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Press F1 if you wish to learn how to use this Help information.

Congratulations! By purchasing the ThunderBYTE Anti-Virus utilities you have taken a first very important step 
towards building a massive anti-viral safety wall around your precious computer system. Setting up the appropriate 
defense, using the TBAV utilities, is a ‘personal matter’. Therefore, we highly recommend you to read the manual 
thoroughly, so you are well aware of all different kinds of security measures you may need to take.

This help file contains the following chapters:

Introduction to TBAV for Windows 95
The basic parts of TBAV for Windows 95 is described in this section
together with the product strategy followed by TBAV for Windows 95.
Furthermore, the license agreement is described and all addresses
of the ThunderBYTE international agents are listed here.

If you wish to contact ThunderBYTE Sales or Technical Support,
you will find ThunderBYTE’s address information here.

Installing TBAV for Windows 95
This part of the TBAV for Windows 95 Setup help file treats the
installation and setup of TBAV for Windows 95 extensively.
You are strongly advised to become familiar with the contents of
this topic.

Using TBAV for Windows 95
The user interface of TBAV for Windows 95 is explained
extensively in this chapter. Reading this chapter is indispensable
in order to get the most out of TBAV for Windows 95.

Using the Scan Module
The operation of TbScan, the Scan Module of TBAV for
Windows 95 is described in this chapter. All options and settings
are explained, together with some information about detection
of viruses.

Using the Setup Module
TbSetup is an indispensable tool when you want to maximize
the functionality of TBAV for Windows 95. The Setup module
calculates fingerprint information of all executable files located
on your computer. This chapter of the TBAV for Windows 95 help
file introduces you to the Setup Module.

Using the Background Scan Module
You can configure TBAV for Windows 95 as a background task,
in which case, it periodically scans specified disks, directories,
or files for viruses. All information about this feature, called the
Background Scan Module, can be obtained by reading this
section of the manual.

Using the File I/O Monitor
The File I/O monitor module performs a virus check on every
file you copy, extract, download, etc. Consult this topic if you
want to know more about the File I/O monitor.

Addressing Special Topics
Some special topics that are not related to any of the above
are discussed in this section. They include: the virus



information database, general configuration, the network
interface and the automatic update feature.

ThunderBYTE Anti-Virus utilities for Windows 95,
Copyright © 1997 ThunderBYTE B.V., The Netherlands.



Double-click this icon to start TBAV for Windows 95.



Double-click this icon to read the last-minute notes concerning TBAV for Windows 95.



This is the TBAV for Windows 95 menu bar. Use the submenus to configure TBAV for Windows 95.



This is the TBAV for Windows 95 drive bar. You can use it while editing or creating so-called targets.



This status message only shows up when TBAV for Windows 95 cooperates with TBAV Administrator



This button should be pressed to initiate a scan operation.



This button should be pressed to initiate the calculation of fingerprint information of executable files.



The virus information database can be accessed by pressing this button.



You can obtain online help by pressing this button.



Press this button to register TBAV for Windows 95



This is the listbox that contains predefined target items, or (when editing a target) a representation of your 
directories and files.



This so-called "target window" lists the items in the currently selected or edited target.



Press one of these target buttons to alter the targets listed in the left-most target window.



The bottom window gives you information about your registration of TBAV for Windows 95.



This small window initially contains some vendor information. If one or more viruses are found, this window will 
contain a list of all virus infections.



In this area the directory being searched for files is displayed.



This is a scrolling list of scanned files. The way of scrolling can be adjusted via the TbScan|Options menu.



This part of TbScan's window specifies the internal format of each file.



This is where TbScan displays the heuristic flags of the scanned files. Heuristic flags denote special characteristics 
of executable files.



The status of scanned files, either clean (marked by “Ok”) or infected (marked by an “X”) is displayed in this area.



The right-most part of TbScan's window displays general information about the scan process.



This part of the "Virus Found!" dialog represents the item being infected (eg., a pathname of a file), together with 
the type of infection and the name of the virus.



A list of heuristic flags of the infected item is found in this area. Heuristic flags tell a lot about the behaviour of a 
virus.



Select this button if you want to delete an infected item.



Select this button to kill an infected item. "Killing" means erasing an item using a secure algorithm.



To rename an infected file, select this button. The first letter of a file's extension will become the letter 'V'. Hence, 
"COMMAND.COM" becomes "COMMAND.VOM".



The 'Validate' option can be used to tell TbScan that this file is not infected. Use this option with care!



Select the "Quit" button to exit TbScan when a virus is found.



Selecting this button makes TbScan continue until all targets are scanned. The "Virus Found" dialog will no longer 
be displayed.



To continue the scan process, select this button.



Perform the action selected in the left-most window.



Obtain information about the detected virus via this pushbutton.



For online help about the "Virus Found" dialog, push this "Help" button.



Using TBAV for Windows 95
This section, and the ones that follow, describe in detail how to use TBAV for Windows 95.
This section describes how to use “Targets,” an extremely important feature of TBAV for Windows 95.

Understanding “Targets”

First, let’s define “Target.” A target is a list of drive names, directory names or file names that either the Setup 
Module, Scan Module or Background Scanning Module can process. TBAV for Windows 95 initially shows all 
available targets in the left Target window.

During installation of TBAV for Windows 95, some predefined targets are generated depending on your system 
configuration. Besides these predefined targets, you can easily define your own targets. For example, you want 
might to create a Target called DOWNLOAD that contains the directory you use for downloading programs. If you 
downloaded some files, and want to see if they contain viruses, you would only have to select the DOWNLOAD target 
and activate the TBAV for Windows 95 Scan module.

Understanding Predefined Targets

As it examines your system, the TBAV for Windows 95 installation utility generates some predefined targets and 
displays them the first time you execute TBAV for Windows 95. Depending upon your system configuration, the 
TBAV for Windows 95 installation utility will create the following targets (if the target items are available):
- First floppy disk drive
- All local fixed disk drives
- All Network drives
- All CD-Rom drives
- All drives

The right “Target” window always displays the contents of the currently selected target in the left window.

Storing Targets

Targets are an essential part of TBAV for Windows 95, but can also use them in TBAV for DOS. For that purpose, 
you should store the targets in simple ASCII file, using SCN for the file extension. The target file First floppy disk 
drive.Scn, for example, would contains the following line:

A:\
NOTE: You must store Target files in the ThunderBYTE Anti-Virus directory (C:\TBAV, for example).

Editing Targets

You can easily change an existing target by following these steps:
1. Select the Target you want to change, and then select the “Edit target” button. Notice that the left “Target” 

window changes to a“Directory” window, which graphically represents the directory structure of the default 
drive, and the action buttons change, as in the following figure:



In this example, the directory structure of the G: drive appears in the left window. The window displays all 
subdirectories and files in that particular drive. TBAV for Windows 95 distinguishes directories, files and 
executables by placing a different icon next to the name of the item:

- The folder icon [ ] denotes subdirectories, such as DOS.
- The window icon [ ] denotes executable files (such as LOGIN.COM).
- The file icon [ ] denotes ordinary files (in the example, the file called PASSWD).

2. Double-click a folder icon or subdirectory name to open the folder and display the contents of that particular 
subdirectory. In this example, the ETC directory is open (notice the open folder icon [ ]). Double-clicking an 
opened folder“closes” the subdirectory (the icon changes into a normal folder icon, and the contents of that 
subdirectory disappears).

3. To select a directory or a file to include in the “Target,” simply select it. By clicking the left mouse
button on the item, you can select one or multiple items. Selected items appear in reverse color. In our example, 
LOGIN.COM is selected.

TIP: If    you want to clear the current selection(s) in the directory window, simply double-click the first line of 
the directory window (the line where the grey drive icon appears). Notice also the vertical and horizontal scroll
bars in the Directory window, which enable you to scroll to data that is not currently visible.

4. After selecting directories and/or files in the current Directory window, click on another drive icon in the upper
left corner to change to another drive, and then select other directories and files. Targets often consist of several
drive names, or directory names located on different drives.

5. After selecting one or more items, select the “Add item” button to copy the items from the “Directory” window
to the “Target Items” window. A couple of guidelines are in order here:

- You cannot add an item that already exists in the “Target Items” window. If you try, TBAV for Windows 95
simply ignores it.



- If you set the “Include subdirectories” option in either the Scan module (TbScan, Options) or the Setup 
module (TbSetup, Options), both of which are set by default, TBAV for Windows 95 includes all 
subdirectories of a given pathname in the Scan or Setup process whenever that pathname is set up or 
scanned. If you set thisoption, you cannot add a subdirectory of a target item to the “Target Item” window. 
For example, if the “Target Item” is C:\, adding the DOS directory to the “Target Items” window is 
redundant because the DOS directory is already included.

- You cannot add an open folder to the “Target Items” window. You should close the folder (by double-
clicking on it) before selecting and adding it to the target.

6. To remove an item from the “Target Item” window, thereby excluding it from a Target, simply select the 
item(s), and then select the “Remove Item” button. To remove all the items in the “Target Item” window, 
simply select the “Clear Target” button (you do not have to select the items first).

7. After editing an existing Target or creating a new Target, you will most likely want to save the Target for future
use. Select the “Save Target” to display a dialog box which contains a list of existing target files.
If you are editing a Target, the default name for the edited target is its original name. If you arecreating a new 
target, be sure to type in a new name. You could also select one of the existing targets, in which case TBAV for 
Windows 95 displays a dialog box warning you that it will overwrite the existing target file with the new target
file. Be surethis is what you want to do.

8. Select the “OK” button restores the left window to the “Predefined Targets” mode. Note that the contents of the
“Target Items” window does not change, unless you select another target out of the list of predefined targets. 
CAUTION: The contents of any unsaved target is lost when you select another target in the “Predefined 
Targets” window.

Creating New Targets

Creating a new target is virtually identical to editing an existing target. The only difference is that after selecting the 
“New Target” button, the “Target Items” window is completely empty. Simply define and save the new Target in the 
same way you edit an existing Target.

Removing Existing Targets

TBAV for Windows 95 not only enables you to create new Targets and editexisting Targets, but it also enables you to
remove existing Targets. You might want to do this, for example, when the layout of your fixed disk(s) has changed 
or a when the directory tree has changed.
To delete a Target, simply select it, and then select the “Remove Target” button. TBAV for Windows 95 displays a 
message asking you to confirm the removal of the target. Select the “Yes” button to delete the Target or “No” to 
cancel.



These buttons can be used to add or remove items to a target. You can also clear and save a target file. By pressing 
"Ok", the list of predefined targets is displayed.



This window shows the directory- and file-tree of the currently selected drive. Select files or directories here to add 
them to the target being edited or created.



Using the Scan Module
This section describes the most important and probably the most frequently used part of TBAV for Windows 95, 
namely, the Scan module. The Scan module detects both known and unknown viruses in files and special areas of 
disks. You can configure the Scan module using several options, all of which you can access via the TbScan menu.

Activating the Scan Module

The Scan module uses a Target, as described in a previous section, as its input. You should, therefore, select or create
a target before activating the Scan module. NOTE: The Scan module always uses the current contents of the “Target 
Items” window as a target. Refer to Using TBAV for Windows 95 for more information about using TBAV for 
Windows 95.
You can activate the Scan module in one of two ways:

1. Select a Target in the “Predefined Targets” window, and then select the “scan” button.

2. Double-click on a Target in the “Predefined Targets” window.

The Scan module immediately starts processing the items listed in the “Target Items” window immediately.

Using the Scan Module

Activating the Scan module displays the following dialog box:

This dialog box, which is very similar to the one in the Setup module, consists of four parts:
1. The message window at the top of the box for displaying information on infected or changed files. In this 

example, the message window contains a reference to a virus. By default, this window displays some vendor 
information.

2. The directory window under the message window display the name of the currently processed directory.

3. The file window in the bottom-left corner of the box display the files that have already been scanned for 
viruses, along with some status information concerning those files. This status information consists of a 



description of the internal format of the scanned file, heuristic flags that describe the file contents (and, if the 
file is an executable file, its behavior), and an indication whether or not the file is infected by a virus.

4. The statistics window to the right of the file window displays information concerning the scan process.

The “Stop” or “continue” button at the bottom of the box for aborting a scan or continuing an operation. If TBAV for
Windows 95 is scanning one or more files, the “Stop” aborts the scan. It is also possible that TBAV for Windows 95 
is waiting for user input (for example, when you’ve set the “Prompt for pause” option). In this case, selecting the 
“Continue” continues the scanning process.

Scanning for Viruses

Depending upon what options you specify, the Scan module processes a number of files each time you activate it. It 
scans each file separately for both known and unknown viruses. During the scan process, it displays the scan results 
for each fill in the file window. For example, the file window might contain the following line:

SIZER.EXE <DOS Exe> AZ Ok

The first field in this line specifies the name of the file just scanned (SIZER.EXE).
The second field describes the internal file format of the file. The TBAV for Windows 95 Scan module distinguishes 
for example Dos .COM files, Dos .EXE-files, MS-Excel files, MS-Word files etc. etc.
The third field, which in this case consists of the capital letters A and Z, displays one or more warning characters, or 
“heuristic flags,” concerning the scanned file. During virus scanning, the Scan module checks the behavior of the 
file being scanned.TbScan summarizes the result of this behavior checking using several uppercase characters, each 
denoting a special behavioral characteristic of the file. Since the behavior checking, of course,    detects common 
virus behavior, the uppercase warning flags might indicate a virus. It is quite likely, however, that your system 
contains a few files that are not infected by a virus at all, but which still trigger one or two heuristic flags. There is 
little to worry about in such a case.
CAUTION: You can ignore the heuristic flags if only a few files trigger heuristic flags. If your computer 
system behaves “strangely” and a large number of files display the same serious heuristic flags, it is quite well
possible that these files are infected by a yet unknown virus.
TbScan also uses the warning characters to indicate illegal or incorrect file formats, special files, etc. In these cases, 
it displays the characters in lowercase, indicating a non-serious file characteristic.

In case TbScan detects a virus, you are referred to Detecting a Virus.

Configuring the Scan module

You can configure the Scan module via the TbScan command on the menu. Please select one of the following topics 
to obtain more information about the TbScan menu items.

TbScan Options

TbScan Advanced Options

What If a Virus Is Found ?

TbScan Log File Options

View Log File



Detecting a Virus
When the Scan module detects the presence of a virus, it displays a message in the message window concerning the 
infected file. The Scan module distinguishes six types of messages:

1. “[Name of file] infected by [name of virus] virus.” The file is infected by the virus mentioned.

2. “[Name of file] is Joke named [name of Joke].” Some programs simulate that the system is infected by a 
virus; such a program is a “joke.” A joke is completely harmless.

3. “[Name of file] is Trojan named [name of Trojan].” The file is a Trojan Horse, a “carrier” program for 
viruses. A Trojan Horse itself is not a virus, but it installs a virus onto your computer system when it runs. Do 
not execute the program; delete it.

4. “[Name of file] damaged by [name of virus].” Unlike an infected file, which carries the virus itself, a 
damaged file has only been damaged by the virus.

5. “[Name of file] dropper of [name of virus].”      A “dropper” is a program that has not been infected itself, but
which does contain a boot sectorvirus and is able to install it into your boot sector.

6. “[Name of file] garbage: (not a virus) [name of garbage].” Unlike an infected file, which contains the virus 
itself,.an overwritten file has been overwritten with “garbage.”

The TBAV for Windows 95 Scan module might at some point use the prefix “Probably” or “Might” before one of 
the above messages. For example, you might see the message, “C:\SOMEFILE.COM probably infected by an 
unknown virus.” Such messages appear in case of yet unknown viruses after the Scan module applies heuristic 
analysis to the file. If the prefix is “Probably,” it is most likely the specified file is infected by an unknown virus. If 
the prefix is “Might,” the probability that the file is really infected by a virus is a lot smaller, but is still possible.

By default, if TbScan detects a virus, it displays a dialog box similar to the following:



The first line in the dialog contains a reference to the infected file, together with the type of infection and the virus 
name. The list of heuristic flags and their textual description appears below this line.The dialog box then lists at the 
bottom of the box the actions you can perform:

- The default action is to rename the infected file, replacing the first letter of the extension with the letter “V.” 
EXE, for example, become VXE.

- Another action is to select the “Continue” button. In that case, the virus scan process continues scanning.
- The third action is the “Non-stop continue” action. When you select this action, the Scan module continues 

scanning without stopping, even if it finds additional virus infections.
- You can abort the scan process by selecting the “Quit” option.
- The “Delete file” option simply deletes the infected file.
- The “Kill file” option is the same as the “Delete file” option, except for that you cannot undelete a killed file 

using a file undeleting utility (such as the DOS UNDELETE command).
- The “Validate” option is only enabled when the fingerprint information of the specified file stored in ANTI-

VIR.DAT no longer matches the real contents of the file. In this case, the Scan module informs you that the file
has changed. Now, if you are absolutely sure that the file cannot be infected by a virus, you might want to 
select the “Validate” option. By doing so, the Scan module no longer pops up the dialog if it scans that 
particular file and finds the fingerprint information does not match. Please note that virus infections are still 
detected, even if a program has been validated!

- The “Clean file” (in case of an infected file) or “Immunize disk” (in case of an infected bootsector of a 
diskette) option can be used to clean infected files (in other words: to remove the virus infected from the file 
without removing the file itself). This option is only enabled when the infected item can really be cleaned or 
immunized.

- For infected WordDocuments or ExcelSheets, the “Erase all macros” and “Erase all macros (nonstop)” options 
will be enabled. You can use these options to make sure that all macros will be deleted from the infected 
document. If you want to remove all macros from all documents or sheets that TbScan comes across while 
scanning, without user interaction, you can select the “Erase all macros (nonstop)”

Notice the two buttons at the right side of box labeled “Virus info” and “Help.” The latter provides on-line help for 
the dialog box. If you press the other button (“Virus Info”) displays some information on the detected virus. This 
information, for example, consists of the file types the virus infects, the length of the viral code, the action the virus 
actually performs, and some information about how to remove the virus from your computer system.



Once you select an action, select the “OK” button on the right side of the dialog box to carry it out.



TbScan Options
Selecting “Scan Options” in the TbScan menu displays the TBAV for Windows 95 Scan Options dialog box. This 
contains several options that you are likely to want to change. These options include the following:

“Prompt for pause.”
If you set this option, the Scan module waits for user input before redrawing the file window. This enables you to 
examine the scan results without having to consult a log file. This option is off by default.

“Quick scan.”
The Scan module usually scans each file for viruses. If you set this option, however, the Scan module checks only 
the fingerprint information (in the form of ANTI-VIR.DAT files generated by the Setup module) of files, if 
available. It scans files normally in cases where the fingerprint information no longer matches the real file contents, 
or if the fingerprint information is not available. This option is off by default.

“Non-executable scan.”
If you select this option, the Scan module scans for viruses in all files. Normally, it scans only executable files. We 
recommend that you leave this option off, since a virus must execute to perform what it is programmed to do, and to 
execute a virus you first need to execute an executable program. So, since the computer cannot run non-executable 
files, it makes no sense for viruses to even infect those files. Some viruses do write to non-executable files, but this 
is simply a result of “incorrect” programming. And while they do contain corrupted data, they still will not harm 
other program or data files.

“Repeat scan.”
This option is particularly useful for scanning multiple diskettes. If you enable this option, when the Scan module 
finishes checking a disk, a small dialog window appears asking you whether or not you want to repeat the scan 
process. If you disable thisoption, the Scan module simply quits after scanning a disk.

“Boot sector scan.”
Each disk, either a floppy disk or a hard disk, contains a small area called the boot sector, which is used for booting 
the computer. Some viruses (the so-called bootsector viruses) infect that particular area of a disk so that they activate
each time you boot from the infected disk. If you enable this option, the Scan module searches for viruses in this 
area. This option is on by default.

“File scan.”
If the option FILE SCAN is enabled, the Scan module will search for viruses in files. This option is enabled by 
default. However, suppose you have been struck by a boot sector virus, and want to search the boot sector of all your
floppy disks for that virus. In such cases you might want to disable scanning of files; hence, deselect the FILE 
SCAN option.

“Subdirectory scan.”
By default, the Scan module automatically searches and scans files in subdirectories of a given target item. If you 
scan a certain directory that contains subdirectories, the Scan module not only scans files in the directory, but scans 
files in the subdirectories as well. If you instruct the Scan module to scan only a single file, it does not scan 
subdirectories. Clear this option if you do not want the Scan module to automatically scan subdirectories.

“Fast scrolling.”
By default, the Scan module makes use of a special scrolling algorithm when displaying processed files. We 
designed the algorithm to consume the least overhead in the course of the virus scan process. The scrolling method 
is somewhat unusual, however. By clearing this option, TbScan uses conventional scrolling.



“Scan inside archive files.”
The scan module can look into archive files and scan the files in that archive that are possible targets for virus 
infections. While scanning a file located in an archive, the scanner will extract the file to memory and scan it. If you 
want TbScan to scan file in archives by default, you should enable this option.

“Don’t scan encrypted files in archives.”
Some archive-utilities allow you to encrypt individual files with a password. By default, TbScan will prompt you for
the password if an encrypted file is encountered. However, if you do not want to scan such encrpyted file you can 
select this option.



TbScan Advanced Options
For novice users we recommend that you do not alter the settings from the Advanced Options in the TbScan menu, 
but as your knowledge and experience grow, you might want to experiment. The advanced scan options include:

“High heuristic sensitivity.”
While TbScan always performs a heuristic scan on processing files, it reports a file as being infected only if it is 
very probable that the file is infected. If you select this option, on the other hand, TbScan is somewhat more 
sensitive. In this mode, TbScan detects 90% of the new, unknown viruses without any signature. Be aware, however,
that some false alarms might occur.

“Auto heuristic sensitivity.”
By default, TbScan automatically adjusts the heuristic detection level after it finds a virus. In other words, when 
TbScan finds a virus, it then proceeds as if you had selected “High heuristic sensitivity.” This option provides you 
maximum detection capabilities in case you need it, while at the same time keeps false alarms at a minimum.

“Low heuristic sensitivity.”
In this mode TbScan almost never issues a false alarm. It still, however, detects about 50% of the new, unknown 
viruses.

“Configure executable extensions.”
By default, TbScan scans only those files that have a filename extension that indicates that the file is a program file 
or a document file.Viruses that do not infect executable code nor infect document files simply do not exist. Files 
with the extension EXE, COM, BIN, SYS, 386,CPL, DLL, DRV, FON,  OV?, DO?, XL?, SMM, SCR, BAT, 
BTM or BOO are considered executable. Note the wildcard, in for example the OV? specification. This includes 
files such as OVR and OVL.

There are, however, files other than those with a default scan extension, that have an internal layout that makes them
suitable for infection by viruses. Although it is not likely that you will ever execute most of these files, you might 
want to scan them anyway. Some filename extensions that might indicate an executable format include:.MOD (MS-
Windows file) and .APP. While infection of such files is not likely, you might want to scan them once in while. To 
force TbScan scan these files by default, select this option and fill out the extensions you want TbScan to scan. For 
example, you can specify .MOD.APP (with no spaces in between). You can use the question mark to specify a 
wildcard character.

WARNING: Be careful what extensions you specify. Scanning a non-executable file causes unpredictable results 
and can result in false alarms.

“Scan all (non-executable) files as executables.”
You can configure TbScan to scan all files instead of only scanning executable files. By default however, TbScan 
uses an other approach for scanning non-executable files. To make TbScan treat a non-executable file as if it is an 
executable file, you can select this option.



What If a Virus Is Found ?
The “If virus found” menu item of the TbScan menu enables you to specify the action the Scan module takes when it
detects a virus:

“Try to automatically clean first, otherwise...”
If this option is selected, TbScan will upon detection of an infected item first try to clean it, if possible. If the clean 
operation is not successful or it is not possible to clean the infected item, TbScan will perform one of the other 
actions selected in this dialog. If the infected item is sucessfully cleaned, the infection will only be listed in the 
message window. No other notification will be given to the user.

“Present action menu.”
This option (the default) instructs TbScan to display a menu listing three possible actions if it detects a virus:    “just 
continue,” “delete,” or “rename” the infected file.

“Just continue (log only).”
By default, if TbScan detects an infected file, it prompts you to delete or rename the infected file, or to continue 
without action. If you select this option, however, TbScan always continues. We highly recommend that you use a 
log file in such situations, since a scanning operation does not make much sense if you don’t read the return 
messages (see the “Log File Menu” option below for further information).

“Delete infected file.”
By default, if TbScan detects a virus in a file it prompts you to delete or rename the infected file, or to continue 
without action. If you select this option, however, TbScan deletes the infected file automatically, without prompting 
you first. Use thisoption if you know your computer is infected by a virus and you want to erase all files the virus 
has infected. Make sure you have a clean backup and that you really want to get rid of all infected files at once.

“Kill infected file.”
This option is almost the same as the “Delete infected file option with one major difference: you cannot use an 
UNDELETE utility to recover a “killed” file. Files that are deleted using the “kill” option are deleted in such a way 
that recovery is no longer possible.

“Rename infected file.”
By default, if TbScan detects a file virus it prompts you to delete or rename the infected file, or to continue without 
action. If you select this option, however, TbScan renames the infected file automatically, without prompting you 
first. By default, TbScan replaces the first character of the file extension by the character “V.” It names an .EXE file,
to .VXE, for example, and a .COM file to .VOM. This prevents the execution of infected programs and thereby 
spreading the infection. This also enables you to keep the files for later examination and repair.

“If a Word Document or Excel Sheet is found, remove all macro’s if possible”
Viruses that infect Word Documents or Excel Sheets use special macros as the infection mechanism. To make sure 
that all documents and sheets that TbScan encounters while scanning are not infected by (unknown) viruses you can 
use this option to instruct TbScan to remove all macro’s in such files if possible.



TbScan Log File Options
The TBAV for Windows 95 Scan module can create a log file of the scan procedure, containing complete filenames, 
virus names and heuristic flags. To reduce the size of the log file, you can configure its contents in several ways, 
using the “Log File Options” item of the TbScan menu:

“Log only infected file.”
This logs infected files, that is, files infected by either a known or unknown virus.

“Log summary too.”
This is the same as the first option, but adds a short summary of the scan process to the log file.

“Log suspected too.”
Use this option if you also want to keep track of files that trigger the default heuristic level (so-called suspected 
files).

“Log all warnings too.”
This option lists in the log file files that trigger one or more heuristic warnings.

“Log clean files too.”
This option Includes an entry in the log file for each file being processed.

“Output to log file.”
Setting this option instructs the Scan module to create the log file. You then use the options above to specify the 
exact contents of the log file.

“Append to existing log file.”
In some cases, you might want to keep the current contents of the log file, and add new entries at the end of the file. 
This option enables you to do this.
NOTE: You still must set the “Output to log file” option to write the scan results to the log file.

“No heuristic descriptions.”
By default, the Scan module specifies the heuristic flags triggers for each entry in the log file using the warning 
character itself and a small description. For example, if some file triggers the “#” flag, the description “Found a code
decryption routine or debugger trap.    This is common for viruses but also for some copy-protected software” is 
added to the log file. Since the size of the log file might become rather large because of these descriptions, you 
might not want to include these descriptions. By setting this option, TbScan omits these descriptions the log file.

“Log file” button.
Selecting this button enables you to choose a filename for the log file. You can either choose an existing file or type 
the name of a non-existing file. In the latter case we recommend you use the extension .LOG for the file name, since
this corresponds to the more or less standard naming convention. The Scan module uses the specified name during 
all subsequent Scan operations until you change the name again. By default, the log file name is TBSCAN.LOG and
resides in the TBAV for Windows 95 directory.



View Log File
This option enables you to view the log file created by the Scan module. Selecting this option displays the contents 
of the log file. By default, TBAV for Windows 95 uses NOTEPAD as a text file viewer. Within NOTEPAD, you can 
print the contents of the log file by selecting the File menu and then selecting Print.

NOTE: You can use your own favorite file viewer instead of the default TBAV for Windows 95 file viewer by using 
the “TBAV for Windows 95 configuration” item of the “Options” menu.



Using the Setup Module
The Setup module of TBAV for Windows 95 collects fingerprint information of all the executable files on your 
system. The Scan module uses this fingerprint information, which it stores in special ANTI-VIR.DAT files (one in 
each directory), to check whether a certain executable file has changed (which might indicate a virus infection). The 
virus cleaning utility TbClean (which is part of TBAV for DOS) uses this information to recover the original 
contents of an infected file.

CAUTION: We recommend that you use the Setup module only during first-time installation of the ThunderBYTE 
Anti-Virus utilities or for new applications. Suppose you apply the Setup module after a virus has infected some 
executable files. The setup module in this case validates the infected programs! We recommend that you first scan 
the target you want to apply the Setup module to for viruses. In this case you ensure that infected files are not 
validated by accident.

The Setup module of TBAV for Windows 95 uses a separate data file to recognize special program files. Such files 
demand special attention. This TBSETUP.DAT data file is part of the standard TBAV package.
NOTE: The TBSETUP.DAT file itself also contains a lot of information concerning its purpose and the list of special
program files. Since the data file is a normal readable file, you can load it into your favorite ASCII text editor and 
view it. TBAV for Windows 95 even offers you the possibility to view the data file (please refer to the section on 
configuring the Setup module).

The following ThunderBYTE Anti-Virus utilities use the information gathered by the Setup module:

TBAV for DOS
- TbScan. In this case, the information is used for integrity checking.
- TbClean. TbClean uses the information to reconstruct the original contents of an infected file.
- TbScanX, TbCheck, TbFile, TbMem. All these programs use the fingerprint information to maintain 

permission information.

TBAV for Windows / Windows 95 / Windows NT
- Scan module. In this case, the information is used for integrity checking.
- Background Scan module, File I/O Monitor and Application Execution Tracker module (if applicable). These 

modules use the fingerprint information to maintain permission information and additional scan information.

Activating the Setup Module

The Setup module uses a Target file as its input. You should, therefore, select a Target before activating the Setup 
module. The Setup module always uses the current contents of the “Target Items” window as a Target.

You activate the Setup module by selecting the second easy-access button at the left-hand side of the main TBAV for
Windows 95 window:

The Setup module immediately begins processing the items listed in the “Target Items” window

Using the Setup Module

When you start the Setup module, it displays the following dialog box:



This dialog box, which is very similar to the Scan module’s box, consists of five parts:

1. The Message Window. Located at the top of the window, this contains some information regarding the Setup 
module. The contents of this message window does not change throughout the setup process.

2. The Directory Window. Located beneath the message window, this displays the name of the currently 
processing directory.

3. The File Window. Appearing in the bottom-left corner of the dialog box, this displays the files for which the 
fingerprint information has been or is being calculated, together with some status information concerning those
files. This status information consists of the length of the files, a checksum number, the action applied on the 
file, and someflags that indicate special files.

4. The Statistics Window. Located right next to the file window, this displays information concerning the setup 
process.

5. The “Stop” or “Continue” button. If the Setup module is processing one or more files, the button has a “Stop” 
label, which enables you to abort the setup operation. If TbSetup is waiting for user input (for example, as a 
result of setting the “Prompt for pause” option), the button has a “Continue” label while the setup process 
suspends. Selecting the “Continue” button continues the process.

Depending on the selected options, the Setup module processes a number of files each time you activate it. During 
the process, it displays the results for each file in the file window. For example, the file window might contain the 
following line:

PRINT.EXE 00003D28 FCF44580 added 0010

NOTE: Do not be concerned if the information flies too fast for you to read, or if it puzzles you. You will probably 
never need these details anyway.

The first field in this line specifies the name of the file just processed, in this case PRINT. The second field contains 
the length of the file, printed in hexadecimal numbers. The third field is a special 32-bit checksum. TbSetup obtains 
this checksum through an algorithm that computes this checksum by taking the contents of the file into account. The



fourth field specifies one of four actions that TbSetup performs:

- “Added.” Indicates that ANTI-VIR.DAT does not yet contain a reference to the processed file. TbSetup adds a 
new entry for this file in the ANTI-VIR.DAT file.

- “Changed.” Indicates that the ANTI-VIR.DAT file contains an entry for the file but the fingerprint information
no longer matches the real file contents, so TbSetup updates the record.
CAUTION: Keep in mind that a change in fingerprint information might indicate a virus infection.

- “Updated.” Indicates that the ANTI-VIR.DAT file contains an entry for the file. The Setup module has, 
however, changed the permission flags of that entry. The earlier obtained fingerprint information still matches 
the file contents.

- “Removed.” Indicates that the entry in the ANTI-VIR.DAT file that refers to the processed file is removed.

The fifth field specifies the permission flags of the file. TbSetup obtains these flags either from the TBSETUP.DAT 
file (the file that lists special program files), or from the settings manually set or reset by the user.

NOTE: For novice users, the exact meaning of the permission flag number is not very important. We refer users who
do wish to know the meaning of the flags to the TBSETUP.DAT file, which contains a brief description of each flag.

Configuring the Setup module

You can configure the Setup module by means of the TBAV for Windows 95 menu bar. Clicking the “Setup” entry 
displays a menu with the following items. To obtain more information about configuring the Setup module, select 
one of the listed items.

TbSetup Options

TbSetup Flags

Data File Pathname

View Data File



TbSetup Options
The Setup module of TBAV for Windows 95 has several options that you are may want to change. These options can
be accessed via the Options item of the TbSetup menu.

“Prompt for pause.”
When you specify the this option, TbSetup stops after it processes the contents of one window. This enables you to 
examine the results.

“Only new files.”
Use this option if you want to add new files to the ANTI-VIR.DAT database but prevent the information of changed 
files from being updated. Updating the information of changed files is dangerous because if the files are infected, the
information to detectand cure the virus is overwritten. This option prevents the information from being overwritten 
but still allows adding information of new files to the database.

“Remove ANTI-VIR.DAT files.”
If you want to stop using the ThunderBYTE utilities you do not have to remove all the ANTI-VIR.DAT files 
yourself. By using this option TbSetup neatly removes all ANTI-VIR.DAT files from your system.

“Test mode (Don’t change anything).”
Use this option if you want to see the effects of an option without the risk of activating something you don’t want to 
activate. This option instructs the program to behave as it normally would but not change or update anything on your
hard disk.

“Hide ANTI-VIR.DAT files.”
The ANTI-VIR.DAT files are normally not visual in a directory listing. If you prefer them to be normal, visible files,
disable this option. NOTE: Be aware that this option applies only for new ANTI-VIR.DAT files.

“Make executables read-only.”
Since TbFile permanently guards the read-only attribute, we highly recommend that you make all executable files 
read-only to prevent any modifications on these files. TbSetupautomatically does this job for you if you enable this 
option. TbSetup recognizes files that you should not make read-only.

“Clear read-only attributes.”
Use this option to reverse the “Make executables read-only” operation. If you enable this option, TBAV clears all 
read-only attributes on all executable files.

“Include Sub-Directory scan.”
By default, TbSetup searches sub-directories for executable files, unless you specify a filename (wildcards allowed).
If you disable this option, TbSetup does not process sub-directories.



TbSetup Flags
The Setup module includes some options that only advanced users should use. These options allow you to change 
the permission flags of files manually. After clicking the “Flags” item in the “Setup” menu, a dialog box pops up and
you can choose to set flags manually, reset flag manually or use normal flags.

You can specify the flags you wish to set or reset by selecting one or more items from the window at the lower half 
of the dialog box.

“Use normal flags.”
This is the default setting, which you should probably use until you acquire more experience.

“Set flags manually.”
This option is for advanced users only. Using this option, you can manually set permission flags in the ANTI-
VIR.DAT record. This option requires a hexadecimal bit mask for the flags to set; for information about the bit 
mask, consult the TBSETUP.DAT file. The “Define flags to be changed” box lists the flags you can change.

“Reset flags manually.”
This option is for advanced users only. Using this option, you can manually reset permission flags or prevent flags 
from being set in the ANTI-VIR.DAT record. This option requires a hexadecimal bit mask for the flags to reset; for 
information about bit mask, consult the TBSETUP.DAT file. The “Define flags to be changed” box lists the flags 
you can change.



Data File Pathname
The Data File Pathname option of the TbSetup menu enables you to specify the filename of the TBSETUP.DAT file 
and its location. By default, the file is TBSETUP.DAT and appears in the TBAV for Windows 95 directory.

NOTE: The filename you specify must really exist.

You can view the data file with the View Data File item in the TbSetup menu.



View Data File
This option enables you to view the TBSETUP.DAT file used by the TbSetup module. By default, TBAV for 
Windows 95 uses NOTEPAD as a text file viewer. Within NOTEPAD, you can print the contents of the log file by 
selecting the File menu and then selecting Print.

NOTE: You can use your own favorite file viewer instead of the default TBAV for Windows 95 file viewer by using 
the “TBAV for Windows 95 configuration” item of the “Options” menu.



This is where TbSetup shows the special flags of a file to indicate certain characteristics of that file.



The TbSetup statistics are collected in this window.



The CRC (the result of a special mathematical algorithm) of files processed by TbSetup, is written here.



The action performed by TbSetup (e.g., "added" or "changed") is displayed in this area.



The length of the file being processed in displayed here, in hexadecimal notation.



This area of the TbSetup window holds the name of the current directory.



This part of the TbSetup window always contains some information about TbSetup.



The names of the files being processed by TbSetup are displayed here.



Using the File I/O Monitor
The File I/O monitor module performs a virus check on every file you read, write, copy, extract, download, etc. 
Some of the most common actions of computer users are creating and copying files, extracting compressed files, 
modifying files, or downloading files. Furthermore, most users regularly put some diskette in the disk drive(s) of the
computer they are using.Since computer viruses are likely to become active whenever a file is changed, created, 
modified, etc., you really should scan each file you process.

The File I/O Monitor Module automatically scans existing files stored on your harddisk or newly created or 
modified files written to your hard disk. It also automatically checks diskettes inserted in a disk drive.

Activating the File I/O Monitor Module

By default, the File I/O Monitor Module is active in all TBAV for Windows 95 modes. You can disable the module 
by using the configuration dialog, which you can access by selecting the Options, File I/O monitor configuration 
item in the TBAV for Windows 95 menu bar.

Please refer to the “Configuring the File I/O Monitor Module” later in this chapter for configuring, enabling, and 
disabling the File I/O Monitor Module.

Using the File I/O Monitor Module

If you use TBAV for Windows 95 in normal mode (that is, not minimized or iconized), the File I/O Monitor module 
uses the title bar to indicate its actions. Each time the File I/O Monitor scans a file or diskette for viruses, the tile bar
reads “Scanning...”

The status window, which appears after you minimize TBAV for Windows 95, also displays the activity of the File 
I/O Monitor. The first line displays the status of the File I/O Monitor. The second line of the status window displays 
the file being processed by the File I/O Monitor.
NOTE: See the Using the Background Scan Module section for more information about the status window.

Configuring the File I/O Monitor Module

You can disable or enable the File I/O monitoring by using the configuration dialog, which you can access by 
selecting the Options, File I/O monitor configuration item in the TBAV for Windows 95 menu bar. With this dialog, 
you can enable or disable file I/O monitoring.

CAUTION: If the “Enable File I/O Monitor” option is “grayed-out” so that you cannot access it, this means that the 
driver that ships with TBAV for Windows 95 (this driver notifies TBAV for Windows 95 of changes in the internal 
DOS/Windows file system) is not correctly installed. You should reinstall TBAV forWindows 95 (choose “First time
installation” !) in this case.

“Enable File I/O Monitor.”

You can enable or disable the File I/O monitor using this option.

 “Secure mode (don’t allow user interaction).”
If this option is enabled, the File I/O monitor will use as less user interaction as possible. For example, if the file I/O 
monitor discovers an infected file, it will only notify the user of this infected file in secure mode. If the secure mode 
is not enabled, the file I/O monitor will ask the user in the latter case if he wants the operation to be continued or to 
be aborted.



“Try to transparently clean infected files.”
If this option is enabled, the file I/O monitor will try to clean the infected files that it encounters. If the file is 
successfully cleaned you will be notified.

“Allow execution of non-authorized files”
“Deny execution of non-authorized files”
“Allow execution of non-authorized files on the following drives”
The File I/O monitor uses the special checksum files (called Anti-Vir.Dat) created by TbSetup to check the 
autorization of files. If a file does not have a record in an Anti-Vir.Dat file it is considered non-authorized. With the 
listed options, you can specify the behaviour of the file I/O monitor in case a non-authorized file is being accessed.

“Automatically create checksum/authorisation files.”
The File I/O monitor has a built-in feature that it can automatically, without user interaction, create an authorisation 
record in the checksum file of a file that is being copied to a disk. This special option can be used in combination 
with the “deny execution of non-authorized files” setting.



Using the Background Scan Module

The Background Scan module is an extremely valuable part of TBAV for Windows 95. It enables you to scan disks, 
directories, or files periodically.

The benefit of an operating system such as Windows or OS/2 is its ability to run applications in the background. In 
other words, such operating systems are able to run several tasks simultaneously; the task that requires user input is 
the “foreground” task, while tasks that are able to run without user interaction are “background” tasks. You can 
configure TBAV for Windows 95 as a background task, in which case, it periodically scans specified disks, 
directories, or files for viruses. How often it does is totally up to you.

There are really two advantages to this background scanning:
1. Background scanning checks for viruses while you are doing your normal work. In other words, scanning your 

computer for viruses does not cost you any time!

2. You can never forget to perform a virus scan, since TBAV for Windows 95 automatically scans your system.

When active, the Background Scanning module of TBAV for Windows 95 uses only idle time for virus scanning. 
For example, when you are typing some letter in a word processor, there will be little idle time between two key 
presses. The Background Scan module exploits this idle time. Thanks to this mechanism, you can be absolutely sure 
that activating the Background Scan module will either not cause system performance to decline at all or very little.

Activating the Background Scan Module

Before activating the Background Scan module, you should make sure you enable and correctly configure it. You 
can access the configuration dialog box by using either the Options, Background Scan Configuration item in the 
TBAV for Windows 95 menu bar.

See the “Configuring the Background Scan Module” section later in this section for configuring, enabling, and 
disabling the Background Scan Module.

You activate the Background Scan Module by minimizing TBAV for Windows 95. TIP: To minimize a Windows 95 
application, click on the ‘ ’ button in the upper right corner of the window. To maximize the application, click on 
the up arrow. When you minimize TBAV for Windows 95, the main window disappears, and a small window 
containing some status information becomes visible at the bottom of the screen.

If you do not want to see this status window, you can iconize TBAV for Windows 95 by also minimizing the status 
window. If you maximize the status window, the “normal” TBAV for Windows 95 window appears.

TIP: The status window will be displayed by default when you minimize TBAV for Windows 95. However, if you 
prefer TBAV for Windows 95 to show its icon instead of the status window per default, use the General 
Configuration of TBAV for Windows 95. option.

Using the Background Scan Module

After you activate the Background Scanning module, the status window appears. The first line of the status window 
displays the status of the Background Scan module. For example, it informs you about the period of time after which
Background Scan will start. If you disable the Background Scanning module, the first line reads “Background Scan 
is disabled.”

The second line of the status window specifies the target for background scan. You can select a target using the 



Background Scan Configuration dialog box. The last line displays the date and time of the last scan of the system 
(by either background scan or normal scan).

You will probably want to keep track of the actions the Background Scan module takes. If you are using an 
application that runs in full-screen mode, however, the status window disappears behind that application.To make 
the status window always visible, you can configure it as being “always on top.” In other words, the status window 
will always be the top-level window. To do this, activate the Control menu by clicking the box in the upper left 
corner of the window. When the system menu appears, click the “Always on top” item to make the status window 
the top-level window.

NOTE: Be aware that the system menu is accessible only when the Background Scan module is not currently 
scanning. If it is scanning, you can use the system menu to abort the background scan. If you click the system menu 
(or the title bar) of the status window while the Background Scan module is scanning the specified target, a dialog 
box appears and asks you if you want to abort or continue the background scan.

Configuring the Background Scan Module

As mentioned earlier, you can access the configuration dialog box by selecting the Options, Background Scan 
Configuration command. For more information about configuring the Background Scan Module, click the following
topic.

Configuring the Background Scan Module



Configuring the Background Scan Configuration

The Background Scan Module can be configured using the Background Scan Configuration item in the Options 
menu of TBAV for Windows 95.

 “Enable Background Scan Module.”
You can disable the Background Scan Module by clearing this box or enable it by checking this box. It is active by 
default.

 “Background Scan Activity period.”
Specifies the period after which the Background Scan Module should starts scanning. The minimum period is 1 
minute, and the maximum period is 1200 minutes. The default period is 30 minutes. The countdown starts the 
moment you minimize or iconize TBAV for Windows 95.

“Background Scan Module - Target.”
This specifies the target for background scanning. If you select the “Targets” button, a small list with currently 
accessible targets appears, enabling you to choose one of these targets. The status window displays which Target will
be scanned. The default target is LOCAL.SCN, i.e., all local fixed disks.

“Background Scan Module - Priority.”
The default priority for background scan is high - this means that the background scan operation is performed very 
fast, but is it possible that other applications will slow down a bit. To prevent this small decline in system 
performance, you might want to set the background scan priority level to “low.”

“Check for floppy disk upon reboot”
TBAV for Windows is able to intercept the reboot process, in order to prevent your system from booting from an 
infected disk. If a disk is detected in drive A:, TBAV for Windows 95 gives you the option to scan the disk for 
viruses. If the disk is infected, you will receive a message and you must remove the disk from the floppy drive. The 
“scan upon reboot” feature is active by default. 



Addressing Special Topics

Understanding The Virus Information Database

TBAV for Windows 95 includes a comprehensive list of viruses and their descriptions. This virus information 
database is very useful whenever TBAV for Windows 95 detects a virus on your computer system; you can 
immediately access information about the behavior of the virus and (more important) how to get rid of it.

You can access the virus information database in two ways:
- Click the easy-access “virus info” button. This button is displayed below.

- Select the “Virus Information” option from the Documentation menu.

For more information about the virus information database, select the following topic:

Virus Information Database

Please note that the virus information database is only available for registered users.

Understanding General Configuration

As you probably know, the Options menu contains an item entitled TBAV for Windows 95 configuration. Selecting 
this item displays a configuration dialog, which enables you to change the general TBAV for Windows 95 options. 
For specific information about the items in this dialog box, select the following topic:

General Configuration of TBAV for Windows 95

Understanding Network Functionality

TBAV for Windows 95 is fully compatible with TBAV Administrator. In fact, TBAV Administrator requires TBAV 
for Windows, TBAV for Windows 95 or TBAV for Windows NT to run on each workstation.

There’s really no need to go into detail about the interaction between TBAV Administrator and TBAV for Windows 
95 at this point. If you want more information, see the documentation of TBAV Administrator. For now, we will 
discuss the visualization of network activity, together with the configuration of the network interface.

TBAV for Windows 95 normally visualizes network activity on the drive bar. If TBAV for Windows 95 is busy 
processing a request posted by TBAV Administrator, the title bar reads “Servicing network request...” instead of 
“TBAV for Windows 95” If you minimize TBAV for Windows 95, the status window displays network activity.

If the network part of TBAV for Windows 95 is active, an extra menu item appears in the Options menu, namely, 
Network Configuration. Selecting this option displays a small window containing some configuration options.

NOTE: The network part of TBAV for Windows 95 is available for registered users only!



Understanding the Automatic Update Feature

All ThunderBYTE software is updated on a regular basis. Since for large companies it is very annoying to update 
the TBAV for Windows 95 software for each workstation every once in a while, TBAV for Windows 95 comes with 
an automatic update feature !

The Automatic Update Feature makes use of a special, dedicated directory. In the sequel we refer to this directory as 
the “update directory”. If you have enabled the Automatic Update Feature, TBAV for Windows 95 will, each time it 
is loaded, look into this directory to see if modified and/or new files exists in this directory. If so, these files will 
automatically be copied into the TBAV for Windows 95 directory.

TIP: If the update directory is located on a network drive, you’d better make that directory read-only for common 
users. Otherwise each user can place their own files in the update directory, causing TBAV for Windows 95 to copy 
these files!

Now suppose you are a system administrator of a large network with, say, 800 users. You have installed TBAV for 
Windows 95 on the local disk of each workstation. A while after you have installed TBAV for Windows 95, you 
receive an update. If TBAV for Windows 95 wouldn’t offer you the Automatic Update Feature, you (the system 
operator) should install the update manually, at each workstation!. With the Automatic Update Feature however, all 
you need to do during firsttime installation of TBAV for Windows 95, is to dedicate a public server directory to 
TBAV for Windows 95. Next, you enable the Automatic Update Feature, and you specify the public server directory 
as the TBAV for Windows 95 update directory. Now, each time you receive a new release of ThunderBYTE Anti-
Virus, just copy the files into the public server directory and the local copies of TBAV for Windows 95 will be 
updated at each workstation automatically!

Enabling the Automatic Update Feature

The “Automatic Update Feature” can be enabled, or settings can be changed from within the TBAV for Windows 95 
menu. You can alter the settings for the Automatic Update Feature in TBAV for Windows 95 by using the 
Automatic Update Configuration item in the Options menu.

NOTE: Be aware that the Automatic Update Feature only comes in action when Windows 95 is booted. The 
Automatic Update Feature does not come in action when you start TBAV for Windows 95 via Explorer or 
whatsoever.

Understanding the TBAV for Windows 95 Security Features

In order to prevent novice users from using the advanced options of TBAV for Windows 95, some security features 
were implemented. With these security features, a system administrator can disable some of the TBAV for Windows 
95 functions for his users, such as changing the File I/O Monitor settings, executing TbSetup etc.

All TBAV for Windows 95 functions protected by the Security Feature are accessible by default. The system 
administrator should use the Security Options dialog to implement the protection of some of the TBAV for 
Windows 95 functions. The Security Options are password-protected: you can only change the settings of the 
Security Options if you know the system administrator’s password.

If a user would try to do something he or she isn’t allowed to (for example, change the settings of the File I/O 
Monitor), a small dialog box will appear whenever the user tries to access the File I/O Monitor configuration dialog 
box. This dialog box states that the user cannot configure the File I/O Monitor since he (or she) isn’t allowed to.

NOTE: The Security Options are available for registered users only!



General Configuration of TBAV for Windows 95
The items of the general TBAV for Windows 95 options are discussed next. These items can be altered via the 
“TBAV for Windows 95 configuration” item in the Options menu.

“Show status window when minimized.”
If you enable this option, TBAV for Windows 95 will display a small status window in the right-hand side corner of 
your screen when you minimize TBAV for Windows 95 (or when TBAV for Windows 95 is automatically loaded 
when Windows 95 boots). If you minimize TBAV for Windows 95 when this option is deselected, a small “notifier” 
icon will appear in the Windows 95 taskbar so that you now that TBAV for Windows 95 is active. This option is 
enabled by default.

“File view utility.”
TBAV for Windows 95 uses the NOTEPAD application by default as its internal viewer to view and even print the 
Setup data file or a log file created by the Scan module. If you prefer to use another viewer, however, you can 
specify this by typing the pathname of your favorite file viewer in the edit control.

TIP: You might try using Microsoft WordPad as your file viewer by entering WRITE.EXE.

“Virus alert options.”
TBAV for Windows 95 can produce some sound via the internal speaker or sound card when it finds a virus. Using 
the radio buttons under “Audible alerts,” you can specify in which cases TBAV for Windows 95 produces sound. 
“Always” specifies that TBAV for Windows 95 always uses sound when it detects a virus. “Only once” specifies that
TBAV for Windows 95 produces sound only the first time it detects a virus. “Background Scan” specifies that TBAV
for Windows 95 produces a sound only when it detects a virus during background scan. You can also turn off the 
sound option by enabling the “Never” option. “Only once” is active by default.
NOTE: Be aware that the virus counter resets every time TBAV for Windows 95 starts.

The “Flash virus window” option can be enabled to give an extra accent to the window that pops up when a virus is 
found.

“Warning messages.”
By default, a warning window will be displayed when TBAV for Windows 95 is being closed, since closing TBAV 
for Windows 95 will disable all “on-the-fly” virus checking capabilities of TBAV for Windows 95. If you do not 
want to see this warning message each time you quit TBAV for Windows 95, you can disable it via this option.

Another feature of TBAV for Windows 95 is that it can automatically immunize diskettes. An immunized diskette 
has special features to detect the so-called bootsector viruses. By default, TBAV for Windows 95 will ask you to 
immunize a diskette each time you access an non-immunized disk. If you do not want to see these messages all the 
time you can disable it via this option.

The last message that you can disable is the message that appears when a new drive was mapped to the system, for 
example if you map a network drive, or if you hot-dock a portable PC. This messages notifies you that a new drive 
was added to the system, and gives you the oppertunity to scan this drive for viruses. If you want you can disable it 
via this option.



Network Configuration
The dialog for Network Configuration can be accessed by activating the Options menu, and then selecting “Network
Configuration.”. The following items can be altered:

“Asynchronous request timeout.” 
Using this option, you can set in which a workstation should respond to an asynchronous request. Asynchronous 
requests are requests started from TBAV for Networks procedures. This timeout value must be between 5000 ms and
99999 ms.

“Message scan time.”
TBAV for Windows 95 uses this option to set the period of time after which TBAV for Windows 95 should see if any
messages posted by TBAV Administrator are pending. The time given must lie in between 100 ms and 9999 ms 
(milliseconds).

“Blocking message scan time.”
Blocking messages are messages that immediately poll the server. Use this option to set the period of time after 
which TBAV for Windows 95 should check for pending blocking messages. The period ranges from 100 ms up to 
9999 ms (milliseconds).

“Blocking request timeout.”
This option specifies the time in which a workstation should respond to a blocking request. You must set the 
blocking request timeout to a value between 5000 and 99999 ms (milliseconds). 

To accept the modifications, select the “OK” button.

CAUTION: Be aware that changes not become active until you restart TBAV for Windows 95.



Automatic Update Configuration
The settings for the Automatic Update Feature of TBAV for Windows 95 can be altered via an item in the Options 
menu, labeled “Automatic update configuration.” The following settings can be changed: 

“Enable automatic update.”
With this checkbox you can switch the Automatic Update Feature on or off.

“Main update directory (always available).”
The directory containing the updated files (for example, a new release of ThunderBYTE Anti-Virus) should be 
specified using the “Update directory” edit control. If this directory is not available while the update takes places, 
you will get an error message.

“Alternate update directory (might not always be available).”
A second directory containing the updated files (for example, a new release of ThunderBYTE Anti-Virus) can be 
specified here. This directory need not always be available; if it is not present, you will not get an error message.

“Update newer/all files.”
With these two options you can modify the behaviour of the automatic update utility. By default, only files that are 
newer or do not exist in the actual program directory are updated. This option is sufficient is almost all cases. 
However, if you need the update utility to always copy all files from the update directory to the program directory, 
you will have to select the “update all files” option.

“Create log file while updating.” / “View log.”
To get an overview of actions taken by the automatic update utility you can enable the “create log file while 
updating” option. If this option is enabled, the update utility will create a “TbLoad.Log” file in the program 
directory. This file can be viewed by pressing the “View log” button.

NOTE: Be aware that the Automatic Update Feature only comes in action when Windows 95 is booted. The 
Automatic Update Feature does not come in action when you start TBAV for Windows 95 via Explorer or the 
program manager.



Windows 95 boot options
The items of the Windows 95 boot options are discussed next. These items can be altered via the “Windows 95 boot 
options” item in the Options menu.

“Automatically load TBAV for Windows 95 when Windows 95 boots”
If you enable this option, TBAV for Windows 95 will be loaded automatically whenever Windows 95 boots, or when
a new user logs in to the system. When TBAV for Windows 95 is loaded this way, it will be minimized 
automatically.

“Scan target when Windows 95 boots”
With this option, you can tell TBAV for Windows 95 to automatically scan a specified target whenever Windows 95 
boots. When you use this option you can make sure that the specified target (for example, all local fixed disks) are 
scanned for viruseseach day.



Virus Information Database
When you activate virus information, a small dialog window appears containing the names of all viruses included in 
the database. You can quickly locate information about a specific virus by starting to type the name of the virus in 
the edit box. The selection in the list box is updated according to the contents of the edit box.

In the example above, we typed the name “Smiley_Boot;” Smiley_Boot, then, appears in the list box (actually, the 
name appeared after typing only “Smiley_”). Double-clicking a virus name in the list box, or clicking the “View 
Info” button at the right side of the window, displays a window containing information about the virus.

For information about the virus information window, refer to Detecting a Virus.



The "What's New ?" Files
When you activate the “What’s new ?” information, a small dialog window appears containing the names of all files 
residing in the TBAV directory containing update information. Each of these files has an extension that represents 
the version number of TBAV.

The “What’s new ?” files for TBAV are called WHATSNEW.xxx, where “xxx” represents the version number.

If you select one of the files, the file viewer will pop up, showing you the contents of the selected “What’s new ?” 
file.



How to contact ThunderBYTE

About ThunderBYTE

ThunderBYTE Anti-Virus Utilities represents the next generation of anti-virus detection and cleaning software 
against known and unknown computer viruses -- complete with 5 different security levels to help protect against 
viruses: signature and heuristic based scanning technology, generic decryption using real-code emulation, integrity 
checking plus active monitoring.

Created in Europe to combat the growing threat of intelligent and sophisticated viruses around the world, 
ThunderBYTE Anti-Virus Utilities have been the leaders in anti-virus computer software for several years, clearly 
acclaimed as the world's fastest scanner.    Using a combination of traditional and proprietary heuristic "seek-and-
destroy" techniques to ferret out even the newest and stealthiest viruses, trojans, and logic bombs, these utilities 
offer an enhanced level of anti-virus protection at speeds that are unsurpassed in the PC arena.

ThunderBYTE Sales, Support and Upgrades

For power users there is no compromise; only the best will do. In the world of anti-virus utilities, one product stands 
head and shoulders above the pack when it comes to power and speed: the ThunderBYTE Anti-Virus Utilities. 
Within ThunderBYTE Anti-Virus Utilities we integrated both the world's fastest and most advanced virus detection 
engine. 

ThunderBYTE is supported world-wide by a dedicated professional team of anti-virus researchers, technical support
specialists and highly trained, specifically authorized agents. Electronic support is provided 24 hours a day via our 
internet WEB site. Our URL address is: 

http://www.thunderbyte.nl 

You will find the latest software updates at this WEB site.

We can also be reached via CompuServe in the ThunderBYTE Forum (GO TBYTE), WUGNET/WINUTIL Forum 
(GO WINUTIL) and on the Windows News Forum (GO WINNEWS).

ThunderBYTE International Agents

For a comprehensive list of ThunderBYTE International Agents, please select the “List of Agents” topic in the 
“Documentation” menu of TBAV for Windows 95.



Security Options
The items of TBAV for Windows that can be protected by the Security Options are discussed next. The Security 
Options can be altered via the “TBAV Security Options” item in the TBAV for Windows 95 Options menu.

“Change TbScan configuration”
If disabled, the user is not allowed to change any of the TbScan settings (either the normal options, advanced 
options, the log file options and the action to take if an infected or changed file is found).

“Change TbSetup configuration”
If disabled, the user is not allowed to change any of the TbSetup settings. These include the the normal TbSetup 
options, the TbSetup flags and the pathname to TbSetup.Dat.

“Change TBAV for Windows 95 configuration”
If disabled, the user is not allowed to change any of the general TBAV for Windows 95 settings.

“Change Background Scan configuration”
The user is not allowed to change the Background Scan settings if this option is disabled.

“Change File I/O Monitor configuration”
If disabled, the user is not allowed to disable or enable the File I/O Monitor module of TBAV for Windows.

“Change Automatic Update configuration”
The user is not allowed to change the configuration of the Automatic Update feature if this option is disabled.

“Change “Scan upon boot” configuration”
The user is not allowed to change the settings of the ‘Startup when booting’ and ‘Scan target when booting’ features.

 “Change the TBAV Administrator configuration”
The user is not allowed to alter the configuration of the TBAV-for-Networks interface. If TBAV for Windows is not 
registered to TBAV for Networks, or you do not have TBAV for Networks installed, this item will be grayed out.

“Change the Live Internet Update configuration”
TBAV for Windows 95 supports the internet as a media for automatically updating the program’s data files (i.e., the 
virus definition files). By disabling this option in the security options one can prevent users from updating the TBAV
software via the internet.

“Edit target files”
The user cannot edit target files if this option is disabled. By using this feature, a system administrator can create 
standard target files that cannot be altered.

“Save or remove target files”
If disabled, the user is not allowed to save target files. By using this feature, a system administrator can create 
standard target files that cannot be altered or removed.

“Scan network drives for viruses”
If disabled, the user is not allowed to scan network drives for viruses. This option might come in handy in network 
environments where users tend to scan all drives, thus boosting network traffic.

“Cancel TbScan or TbSetup while running”
This is the equivalent of the ‘secure’ switch of the TBAV for Dos utilities. If disabled, the user cannot stop the 



TbScan or TbSetup process while one of these processes is running.

“Continue if an infected or changed file was found”
If disabled, the user is not allowed to continue if an infected or changed file is found, unless the system 
administrator’s password is entered.

“Execute the TbSetup program”
If disabled, the user is not allowed to execute TbSetup. Executing TbSetup is really a one-time process, and 
executing TbSetup over and over again might prevent TbScan from detecting certain classes of viruses. By disabling
this option can prevent noviceusers from accidently executing TbSetup.

“Exit from TBAV for Windows 95”
If disabled, the user is not allowed to exit TBAV for Windows 95.

“Password”
The system administrator can change his password by pressing this button. You will be asked for the old password 
first. Next, you can type in your new password. The latter password should be entered twice for verification 
purposes.

“Select all”
To enable all features for the user, the system administrator can click this button.

“Unselect all”
If you want to disable all options that can be enabled or disabled using the security features, you can press the 
“unselect all” button. You will see that all items become unchecked.
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Incorporation of compression code

ThunderBYTE Anti-Virus for Windows 95 incorporates compression code by the Info-ZIP group, which is used 
with their permission. There are no extra charges or costs due to the use of this code, and the original Info-Zip 
sources are freely available by anonymous ftp from the Internet site ftp://ftp.cdrom.com/pub/infozip/ and from 
CompuServe in the pcprog forum. 

We will also, upon request, mail you the Info-Zip sources if you send a self-addressed stamped envelope to ESaSS 
B.V., P.O.Box 1380, NL-6501 BJ Nijmegen, the Netherlands.



Live Internet Update
The settings for the Live Internet Update feature of TBAV for Windows 95 can be altered via an item in the Options 
menu, labeled “Live Internet Update.” The following applies: 

“Update now.”
If you want to retrieve the latest virus definition files from the internet at this very moment, select the “update now” 
option. After pressing the “OK” button the update program will connect to the internet and download the most recent
definition file.

“Update on a weekly/dayly basis.”
It is possible to make TBAV for Windows 95 automatically download the latest virus definition files once a day or 
once a week. In this case, you’ll always be sure that you TbScan will detect the latest viruses, whithout the need that 
you have to manually download files from the internet.

“Do not update the virus definition files.”
If you are not connected to the internet, or you don’t want the virus definition files to be updated for another reason, 
you should check this option and press “OK”.




